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Introduction
HTML Assistant ©1993,1994 by Howard Harawitz, All Rights Reserved

This is the free version of HTML Assistant.    

There is another version, HTML Assistant Pro, that may be ordered via mail, fax, or Email.

HTML Assistant is a simple text editor with extensions to assist in the creation of HTML hypertext 
documents.    HTML documents are used to access a variety of information sources with a World Wide 
Web browser such as Mosaic or Cello.

This version of HTML Assistant includes:

Context Sensitive Help -- Press the F1 key for help with the currently selected control or menu item

Capability to test your work with a WWW browser at the 'click' of a button -- without leaving the editor

A multiple document interface (more than one file may be opened at one time)

Automatic conversion of Cello Bookmark, Mosaic '.INI' and URL text files to hypertext documents

Autocopy of URLs from Cello Bookmark and Mosaic.INI files to text files

Conversion of HTML Assistant URL files to Cello Bookmark files

A user defined toolbox

Printing of text files

In addition to the above, HTML Assistant Pro includes:

An Automatic Page Creator which permits very rapid creation of HTML text pages for use with WWW 
browser programs.      Minimal knowledge of HTML is required, and attractive screens with your 
own selected hypertext links can be created in a few seconds.

An option to make UNIX text files more readable by converting them to DOS text

An option to save DOS text files as UNIX text

The ability to remove HTML markings from text

Availability of enhancements and upgrades

See also:
How to Order HTML Assistant Pro



Disclaimer
Please use this software at your own risk.    
The author, Howard Harawitz, disclaims any liability for special, direct, indirect, incidental, 
consequential or any other damages believed to have been caused by the use of HTML Assistant 
or any files derived from its use.



Copyright Notice
HTML Assistant and its associated documentation is Copyright ©1993,1994 by Howard Harawitz, 
All rights reserved.
This version of the software, HTML Assistant, may be freely distributed, but all copies must include this 
notice, the Help file and all other files and documents associated with the original distribution package 
without modification. 

Disclaimer

For further information or if you have any suggestions or comments please contact the author, Howard 
Harawitz:

Email: harawitz@fox.nstn.ns.ca

FAX: (902) 835 - 2600



Overview
Keeping an accurate record of    Internet journeys is not a trivial task.    In fact, one of the major criticisms 
of the Internet is that information is not well organized and it is difficult to retrace your steps if you want to 
repeat a search.    Many (if not most) Internet users have found themselves using computers to scan the 
Internet for information while keeping    a pencil and paper handy so that they could make notes about the 
places they had been.

Some Gopher and WWW browser packages permit saving place markers by using 'bookmarks'    or a    
'hot list' to collect address information.    As useful as this is,    after several searches or browse sessions 
these collections quickly become a pot pourri of tags, markers and pointers to a varied assortment of 
Internet places that have no particular relationship to each other.

By making it easy to create your own browser pages, HTML Assistant provides a way to organize and 
keep track of your Internet journeys.

Related Topic:

The Automatic Page Creator



Collecting URLs
World Wide Web browsers use Uniform Resource Locators (URLs) to find and access all forms of 
information on the Internet -- including text files, news groups, mail lists, gopher directories, HTML 
documents, program files, images, sounds, movies, etc.

To use HTML Assistant as an aid to organizing your WWW experience, you first need to begin collecting 
the URLs that point to the WWW sites that interest you.

Two MS Windows browsers, Cello and Mosaic, both permit transferring the URLs which they use for 
Internet access to the Windows clipboard.    From the Clipboard they can easily be copied to any Windows
text editor.

Cello's bookmark    dialog box asks if you want to copy a selected URL to the clipboard.      

Mosaic has a URL text display which can be copied by selecting the text (using the mouse and 'dragging' 
across it) and typing Control-C -- the standard MS Windows key sequence for copying text to the 
clipboard.    

Once the URL text is in the clipboard it can be 'Pasted' into a text file using a simple text editor like MS 
Notepad (supplied with Windows) or HTML Assistant.    Be sure that there is an End-of-Line following the 
URL. An End-of-line is a carriage-return/linefeed pair which is added when you press the 'Enter' key after 
inserting text. That is all that is required to begin collecting URL links for use by HTML Assistant.

Alternatively,    as you explore with a browser, you can save URLs by creating bookmarks (if you are using
Cello) or adding to the 'hot list' (if you are using mosaic).    HTML Assistant's URL file editor/creator will 
permit you to convert Cello bookmark files and URLs collected in Mosaic's Hot List to HTML Assistant 
URL files.    HTML Assistant will permit you to create URL files that combine information collected with 
both browsers.

Files containing URLs should be saved with the suffix, ".URL".      While this isn't absolutely necessary, it 
does make it easier for you (and HTML Assistant) to identify them.



Editing and Organizing URLs
Once you have collected    URLs that point the way to the places you have visited, the next step is to 
select and organize them into separate files that suit your particular needs.    For example you might want 
to create a file containing URLs that can help you learn about Internet resources, or interesting art 
exhibits, or information on animal breeding.    

HTML Assistant provides two ways to do this.    Use whichever works best for you.    

The most familiar way for most people will be to open a new edit window (by selecting 'New' from the 'File'
menu) for each subject and copy/paste selected URLs (and their optional comments) from your general 
URL collection or other URL files to the new one.

The second method involves using the URL file edit popup window that can be viewed by selecting    
'Edit/Build URL Files' from the 'URL' menu.    This permits you to combine commented URLs from different
sources and to use scrolling lists for editing.



Building Browser Pages
The URLs you have collected are pointers to the places you    have visited on your Internet journeys.      
The final step in organizing your personal Internet experience is to incorporate selected URLs into HTML 
documents to be used as WWW browser pages.    These pages will be the tour guides for yourself and 
others who want to retrace your steps.      With HTML Assistant you can easily create browser pages with 
titles, headings and descriptive text, and hypertext links to Internet resources.

HTML Assistant can quickly convert    URL files to HTML hypertext links.    For information about how to do
this see    Direct Conversion of Files to HTML Text.

Using HTML Assistant tools and editing functions you can easily format your links into formatted lists 
(numbered or unnumbered), intersperse them with descriptive text, and create headers in various sizes 
and styles to highlight your page.

HTML Assistant Pro, includes an Automatic Page Creator that makes this part of the job very easy.    It 
guides you through the process of creating a title, headings and descriptive text for your page, and 
enables you to incorporate a list of URLs (from a file of your choice) which will become the links to the 
places you want to visit. With the 'click' of a button    your new page is automatically created and displayed
in an edit window ready for saving as an HTML document. 

Related Topic:
Using your local files with HTML



Using Local Files with HTML
As you create your own HTML files with links to remote sites, you may also want to create other browser 
pages consisting of links to these local files.    By doing this with successive generations of locally created 
files you can create a hierarchical system of    'menu pages' for organizing and indexing your work.

For example, you may have built separate files (with remote links) concerning the following subjects:

Using HTML

WWW and related FAQs

Selected sites via CERN

You might want to create a menu file concerned with general WWW topics that includes the above files as
selectable links.

Creating a Menu Page 
You can build such a file one step at a time, by opening a new edit window and creating a local file link for
each file using the 'Link' button.    When the link popup appears, select the "file://localhost/" prefix from the
prefix list box.      

Next, enter the name of a file, or use the 'Browse' button to select a file name from a file select dialog box.

Clicking the 'OK' button (on the link popup) will cause HTML Assistant to create (and insert into the edit 
window) the URL for a link to the file you selected. It will look something like:

file://localhost/C:\html\myfile.htm
You can continue in this manner to add additional URL links.    Using HTML Assistant's list formatting 
capability, you can select and format the file links as one or more lists (numbered or unnumbered).

When the process of adding and formatting file links is finished you can complete your menu page by 
using HTML Assistant's tools to add a title, headers and explanatory text to your display. 



Tools Overview
HTML Assistant's tools are found on a tool bar at the top of the edit window.

The tools are basically of two types:

Tools that normally involve the selection of text.    (Type 1 tools.)

Tools that insert HTML elements at the cursor (Type 2 tools.)

The tools in the upper part of the toolbar include both Type 1 and Type 2 tools. 

The tools in the lower part of the toolbar are all Type 2 tools which insert HTML markings at the cursor.

There is also a special group of Type 2 tools called 'User Tools.'

To use a tool, simply 'click' on the button with the left mouse button.

See also:
The Auto Repeat Function



Using Type 1 (Bracketing) Tools
To use a Type 1 tool, first select some text by dragging the mouse across it.    Next, click on a Type 1 Tool 
-- the 'Title' tool, for example.    You will see your selected text bounded on each side with HTML elements.
This tells the WWW browser (like Cello or Mosaic) to display that text as a title. 

Most Type 1 tools operate in this manner.    Select some text and try a few of the other tool buttons in the 
upper part of the tool bar.    

The 'List' tool works with several lines of    text.    Select a few lines of text and try it.

A few Type 1 Tools are a bit more complicated.    They ask for additional text to be added by the user as 
part the HTML element that they apply. The 'Link' tool is one of these. So is the 'Anchor' tool.    Try them to
see how they work.



The 'Link' Tool
When the 'Link' button is used, a window pops up asking for selection or entry of a 'URL'.    URLs (Uniform
Resource Locators) are instructions for fetching data.    Each URL type has a prefix (as shown in the URL 
Prefix List box) indicating the kind of data that will be fetched. (See the Beginners Guide to HTML, and 
the specification for Uniform Resource Locators, for more detail.    Both of these documents can be found 
using Cello or Mosaic and looking for WWW information.) 

As you enter and use URLs in your documents they are saved in memory and appear in the URL list box 
whenever the URL data entry window pops up.    You may save the contents of this list box to a file, and 
retrieve the contents of a saved file to the list box by accessing the 'URL File' menu on the URL pop up 
window.

See Edit/Build URL Files.



Using Type 2 (Insertion) Tools
To use a Type 2 tool, simply click on it.    You will see the tool's associated HTML element appear at the 
text cursor.    For most of these, the tool's label or caption is the same as the HTML element that it will 
display.

To keep up with changes in HTML and to permit you to configure the editor to suit your style of working, 
HTML Assistant includes a special tool palette for your own custom Type 2 tools.



User Tools
User Tools are Type 2 (insertion) tools with text provided by the user.

This permits users to create insertion tools that suit their particular style of working.

Up to 10 User Tools can be created.    They can be deleted or modified at any time and are automatically 
saved.

A few user tools are provided with the program package to illustrate what you can do.

If you click the 'User Tools' control you will see the User Tools palette.    You can move it to any convenient
place on the screen.    You can remove it by clicking the 'Close' button on the palette or by clicking the 
'User Tools' button again.

The tools can be changed by clicking on the 'Modify Tools' button on the User Tools Palette. A 'Modify 
Tools' dialog box will pop up.    Simply enter or modify any of the tool text boxes to suit yourself. The text in
each box will show up as the label or caption on a displayed button.      If a text box is left blank, no 
corresponding tool button will be shown.

Click on the 'OK' button to save your new tools.    Selecting the 'Cancel' button will prevent the changes 
from taking place.

Your custom tools will be saved for use in future editing sessions.

See also:
Creating Tools that Insert an EOL (Carriage Return/Line feed)



Creating Tools that Insert an End-of-Line
To create a user defined tool that inserts a carriage-return/linefeed pair (End-Of-Line marker) enter "\n"    
-- without the quotation marks --    in the caption where you want the EOL to be created.

For example to create a tool that inserts an EOL followed by a paragraph mark followed by another EOL 
you would use the following text in the tool's caption:

  \n<P>\n



The Auto Repeat Function
To repeat the action of the tool that was last used, simply press the right mouse button or press CTL-R.    
This function is also available from the 'Command' menu and as a command button in each file display 
window.



Autoinsert Paragraph Markings
Found in the 'Command' menu this item will insert new paragraph marks ("<P>") at every End of Line 
(carriage return-line feed pair) in the selected text.    You must select text for this command to work.

To automatically insert paragraph marks in the whole file, select the 'Select    All' option from the 'Edit' 
menu, and then use the 'Autoinsert Paragraphs' command.



Printing
The contents of the current edit window may be sent to the default Windows printer by selecting the 'Print'
option in the file menu.

This is a simple print routine that transfers the text (as a 'string') to the printer.    If a line ending with a 
CR/LF pair is longer than the width of a page, the end of the line will not be visible when printed.

Files that have no CR/LF pairs (i.e., some UNIX files) may appear as a single (truncated) line of text.

For more elaborate print formatting you can use any word processor that will accept standard text files. 



Edit/Build URL Files
Selecting this item from the 'URL' menu permits you to edit and combine commented URLs    (URL    is an 
abbreviation for Uniform Resource Locator) from different sources.

For example, you may quickly combine selected URLs from    Cello Bookmark files with other URLs 
automatically extracted from Mosaic menus and 'Hot Lists.' 

While perusing news groups, mailing lists, etc., you might cut and paste URLs into text files (with Notepad
or HTML Assistant)      and later combine these with    other files.

Of course, once the URLs    and comments from various sources are loaded into the editor's list boxes 
they may be edited and supplemented with new URLs that are manually typed in.    If they are saved    as 
HTML Assistant URL files (the default type) they can later be loaded into an edit window for more 
extensive editing and    reorganization.

You may also convert and save any combination of URLs from any of these sources into a Cello 
Bookmark file.

See also:
Operation of the URL Editor



Operation of the URL Editor
When the 'Edit/Build URL Files' option is chosen, a window with two list boxes and two text boxes, and 
some control buttons pops up.

When a file is loaded, any necessary conversions (for Cello bookmark) or extractions (for Mosaic.ini files) 
are performed, and the list boxes are filled with the URLs from    the file (the files themselves remain 
unchanged).    One list box contains a list of all the URLs found in the selected file.    The other list box, in 
corresponding positions in the list, contains comments or descriptions of the URLs in the first box.

You may create your own files    or add to the contents of existing files, by clicking the 'Add New URL' 
button and entering URLs and Comments into the corresponding text boxes.    When an entry is complete 
use the 'Accept New URL' control button to save the new data into the list boxes.

Clicking on a data item in either list box causes the URL and its associated comment (if any) to be copied 
to corresponding text boxes.    The contents of the text boxes may be edited and the changes can be 
saved.    Clicking the 'Accept Edited Text' button makes the changes part of the file.    Saving the file will 
make them permanent. You may add and delete URLs and comments by clicking the appropriate control 
buttons.

See also:
Combining Files



Combining Files
Files may be combined by selecting the "Append " option button (displayed between the two list boxes) 
when a file is to be opened and there is data already in the list boxes.    The new data will be appended to 
the existing data.

Files are saved as HTML Assistant URL Files unless the 'Save as Cello Bookmark File...' option in the 
'File' menu is selected.



Direct Conversion Of Files to HTML Text
By selecting the 'Autoconvert File to HTML' option in the 'URL' menu, HTML Assistant permits you to 
automatically convert certain files that contain URLs (along with    optional comments or descriptions) 
directly to HTML text in a new HTML Assistant text editing window.    This is a quick and easy way to build 
HTML files for editing, testing or browsing.

When a file type is selected (from the popout sub menu) you will be presented with a file selector box 
from which you may select a file to convert (or you may cancel the operation).

As soon as a file of the appropriate type is selected, the conversion process begins. In a few seconds 
when conversion is complete    the URLs that were found in the file, now properly converted to HTML text 
separated by paragraph marks, are automatically inserted into a new text window for further editing or 
testing.

 You can elect to convert data in the following types of files to HTML :

Cello Bookmark Files (*.bmk files)

HTML Assistant URL Files (*.url files)

Mosaic Initialization Files (*.ini files)



Cello Bookmark files (*.bmk files)
Cello Bookmark files are used by the Cello browser for saving URLs so that browsed documents may be 
revisited.    They have their own format and their file names usually have the suffix ".bmk".



HTML Assistant URL Files (*.url files)
HTML Assistant URL files are text files containing URLs and, possibly, descriptions or comments.    Each 
record, or line, in the text file contains a URL optionally followed by a comma (,) and a description.

An uncommented line looks like this:
http://info.cern.ch/example.html

A commented line would look like:
http://info.cern.ch/example.html,Sample Page 

Because HTML Assistant can automatically convert these files into an HTML text document, they make 
an excellent way to store or 'capture' interesting looking URLs for later perusal. 

If, for example, while browsing news groups, mailing lists or the World Wide Web itself,    the URL for an 
interesting looking home page is presented, you can simply 'Copy' the URL from the document and 
'Paste' it into a text file using Notepad (or HTML Assistant).    The URL should be saved WITHOUT 
quotation marks. 

If you wish, you may enter a comma (,) after the URL (but before the "Enter" key is pressed), followed by 
a description or comment which will appear as the 'live' or 'clickable' item in the HTML file when viewed by
a browser.    If you don't enter a comment, HTML Assistant will add a copy of the URL (for display as the 
'live' selectable item) to the HTML file at conversion time.

Just be sure you press the "Enter" key at the end of each line.    Make sure that the URL and its comment 
(separated by a comma) appear on one logical line. It may look like two or more lines if the editor window 
is narrow, but as long as the "Enter" key was pressed only at the end of the URL-Comment combination, 
the item is    a single record and will be processed properly.



Mosaic Initialization files (Mosaic.ini)
The Mosaic WWW browser uses an initialization file with the name, "Mosaic.ini" for storage of setup 
parameters.

Included in this file are lists of menu items that contain descriptions and URLs that can be executed by 
Mosaic when the descriptions on the menus are selected (or 'clicked').

Also included in the file is a 'Hot List' of user selected URLs gathered during browsing expeditions on the 
Web.    These do not have descriptors associated with them.

The URLs in Mosaic initialization files are what is    converted to HTML text by HTML Assistant.    If the 
URLs come from menu items their associated menu captions are displayed as the selectable on screen 
text.    'Hot List' items are displayed with a copy of the stored URL as the on screen text.



Using a WWW Browser for Testing
HTML Assistant permits you to display your HTML annotated file (without leaving HTML Assistant) with 
any browser that will permit the use of the name of a file on a local disk as a startup file.

If you click on the 'Test' button in an edit window or select the 'Test' option from the 'File' menu, you will be
led through a process which includes selecting your test program and    saving its name for future use. 

The 'Test' function uses the last saved version of your file. If your file has changed since you saved it last, 
you will be given an opportunity to save it before testing.

Alternatively, you may select the 'Autosave Before Testing' feature in the 'Options' menu, and your file will 
be saved automatically.

The 'Test' button or menu option will be disabled if the active file is a new file and you have not yet saved 
it.    You must always save a new file at least once before you can test it. 

To test the program, HTML Assistant simply runs the program you designate as your test program, with 
the full path and file name of the active edit file in the command line.    Therefore, for the test to work, the 
browser you use must be able to use a local file specified on the command line as its startup file.

You also need to be concerned with    where your test program expects to find configuration files, 
initialization data, etc.    We have sometimes found it necessary to copy some or all of these files to HTML 
Assistant's home directory or to the directory where the files to be tested reside.

We find that Cello and Mosaic (Version 2 or later) work well as test programs. HTML Assistant can take 
advantage of Cello's Dynamic Data Exchange capability.      You can easily try other browsers as they 
become available.



Using Dynamic Data Exchange (DDE) with a Browser
Use of DDE (Dynamic Data Exchange) with a test browser permits relatively smooth back and forth 
transitions from HTML Assistant to the browser and vice versa.    It eliminates the need to close and 
restart the test browser each time you want to test a file.

If you are using Cello as your    test browser, HTML Assistant gives you the option of using DDE (Dynamic
Data Exchange) to send Cello the name of the HTML file you want to test.    If Cello is not loaded, HTML 
Assistant loads it.    Once Cello is loaded and you do not close it, it will not have to be reopened whenever
you want to test a file.    Each time you select the item in the File menu for testing using DDE, the name of
the file you are testing is sent to Cello and it becomes the active, topmost application.

When using DDE, Cello does not always refresh itself if your file has changed.    That is, changes in your 
HTML text will not always be immediately seen when you invoke Cello.    If that happens click the 'Reload 
Document' option in Cello's file menu to ensure that you are viewing the latest saved version of your 
HTML file.

Clicking on the small 'Return to HTML Assistant' box in the lower right    corner of Cello's window will 
return you to HTML Assistant without closing Cello.

The default test mode is DDE off.    To set the DDE option on, go to the 'Options'    menu and click on the 
DDE option.    You can tell it has been selected if it is checked.    That's all there is to it.      If you run into 
problems with DDE, go back to the Options menu and click it again to deselect it and return to the test 
mode without DDE.



What is HTML Assistant Pro?
HTML Assistant Pro is an advanced version of HTML Assistant that may be ordered by Email, mail,    or 
FAX.

While HTML Assistant is a complete and fully functional hypertext editor, HTML Assistant Pro makes 
creating, editing and collecting HTML documents even faster and easier.

HTML Assistant Pro adds the following features to those already included in HTML Assistant:

An Automatic Page Creator which permits very rapid creation of HTML text pages for use with 
WWW browser programs -- minimal knowledge of HTML is required, and attractive screens with 
your own selected hypertext links can be created in a few seconds.

An option to remove HTML markings from text

An option to make UNIX text files more readable by converting them to DOS text

An option to save DOS text files as UNIX text

Availability of enhancements and upgrades

Related topics:
HTML Assistant Pro - Automatic Page Creator

HTML Assistant Pro - Other features

How to order HTML Assistant Pro



HTML Assistant Pro - Automatic Page Creator
The Automatic Page Creator supplied with HTML Assistant Pro permits very rapid creation of HTML text 
pages for use with WWW browser programs.      Minimal knowledge of HTML is required, and an attractive
screen with your own selected hypertext links can be created in a matter of seconds.

For WWW information providers, this makes it quite easy to create pages for others to view.

For active    collectors of information on the World Wide Web, the Automatic Page Creator (as well as 
HTML Assistant Pro's other features) makes it easy to organize    links to information in ways that make 
sense.    You can quickly select links from different pages and files and combine them into a single page 
with headings and descriptions of your choice. 

Be Your Own Internet Organizer
The Automatic Page Creator makes it a snap to organize your Internet experience. It becomes a simple 
matter to create hierarchies of menu pages which access other pages stored on your local disk drive.    All
of these can be annotated with text of your choice. 

The Automatic Page Creator allows you to very quickly put together presentation pages on any topic.    
Together with the URL File Editor/Builder, you can organize links to WWW data by subject, date or in any 
other way that suits you.    

With HTML Assistant Pro you can easily build attractive and pleasing layouts that incorporate headers, 
divider lines, text and links to other pages and graphics on your own hard drive or at remote sites.

HTML Assistant Pro makes keeping track of your work on the Internet not only manageable, but an 
enjoyable and esthetically pleasing experience.

Related topics:
HTML Assistant Pro - Other features

How to order HTML Assistant Pro



HTML Assistant Pro - Other features
It is easier to work with UNIX files
HTML Assistant Pro offers the option of converting UNIX text files to DOS text files so that it is possible to 
read and edit them with HTML Assistant Pro.    Your original file is not altered.    Conversely, DOS text files 
may also be saved as UNIX text.

Remove HTML markings from text
Files may be read without the distraction of HTML markings.

Access to enhancements and upgrades
Registered users of HTML Assistant Pro will receive announcements of upgrades and new products 
which will be available at special prices to existing users.

Related topic:
How to order HTML Assistant Pro



How to Order HTML Assistant Pro
HTML    Assistant Pro may be ordered via Email, mail, or FAX.    The fastest way to order is by FAX or 
Email with a credit card.

Payment may be made by money order, check, VISA or Master Card.

To order or for more information contact the author/publisher as follows:

Email:

harawitz@fox.nstn.ns.ca

FAX: 

(902) 835-2600

Mail:

Howard Harawitz

25 Doyle Street

Bedford, Nova Scotia

Canada B4A 1K4

US Dollar Price    is $59.95 (plus postage and handling) .
If you wish to pay by check or money order in US Dollars send US$59.95    plus US$10.00 for postage 
and handling in North America    (US$15    outside North America).    Total    in US Dollars is $69.95 ($74.95
outside North America).

Credit Card users:    Because we are required to write credit card orders in Canadian dollars the actual 
US$ amount billed by your local bank will vary slightly with the exchange rate at the time your account is 
charged.

Note: Prices are guaranteed for the calendar year 1994.    If you have a question about current pricing 
please FAX, write or Email.

Price in Canada is    C$79.95 (plus postage and handling). 
The price for single copies is      C $79.95    plus C$10 for postage and handling    (delivery anywhere in 
Canada). (C$15 to the US and Mexico, and C$20    outside North America).    

Canadian orders please add 7% GST (and an additional 11% PST in Nova Scotia). 

Total price for Canadians including GST is $96.25 ($106.83 in Nova Scotia).

All Credit card orders must include the following information:
1. Full credit card number      

2. Type of card (Master Card or Visa only) 

3. Expiration date. 

All orders:
1. Be sure to include your full name and post office address, including postal code, with your order.    

2. Please include your Email address, and/or a FAX or telephone number so we can contact you 
quickly in case we need additional information.

3. Shipment in North America will be via post.    FAX or Email if you would like to make other 
arrangements.



About purchase orders, multiple licenses and quantity discounts
Arrangements can be made to accept purchase orders from schools, established firms, government and 
other organizations.

Institutional licenses and quantity discounts are available. 

Email    harawitz@fox.nstn.ns.ca or FAX (902) 835-2600 for information.

Equipment requirements, diskettes, video, etc.
HTML Assistant Pro requires an    80386 (or better) IBM PC or compatible computer with at least 4 
megabytes of RAM, Microsoft Windows 3.1 (or later) and less than 1 MB of hard disk drive space.    (If you
are now using HTML Assistant, you can use HTML Assistant Pro with the same equipment.)

Unless otherwise specified, the software will be sent on a 3.5 inch high-density diskette.    If you require 
other media please let us know.

RE: Video adapters

HTML Assistant and HTML Assistant Pro run successfully with just about all video adapters when using 
256 (or fewer) colors.

 If you are using HTML Assistant successfully you will have no video problems with HTML Assistant Pro 
(when used with the same video mode).    

Some people have reported problems (GPFs) when attempting to use HTML Assistant with 32K or more 
colors .    We are investigating the cause of this.    If you plan on using 32K (or more) colors please contact
us.      We suggest you try running this version (HTML Assistant) on any machine with which you think you 
may have a problem.    If    HTML Assistant runs successfully, HTML Assistant Pro will also work.




